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Memories Builder DVD Version 2.1  
User’s Guide 
 
 

Introduction 
 

What is Memories Builder DVD? 
Memories Builder DVD is a software application for creating a multimedia supplement to 
the print yearbook on DVD in the DVD-Video format. Since this format is built for 
video, the supplement should be based on video footage, but can also include slideshows 
of images. 
 
What does Memories Builder DVD do? 
Memories Builder DVD helps you organize your content into a series of menus and 
objects, such as videos and slideshows. It also gives you the tools to create your 
slideshows and create a look for the DVD. Finally, it prepares your project to send to 
Yearbook Interactive for encoding onto a DVD and duplication. 
 
For more information about the DVD presentation, including definitions of basic 
concepts like menus and buttons, see DVD Concepts on page 6. 
 

 
Copyright Information 

Memories Builder DVD Version 2.1 
Copyright  2005 StoryRock, Inc. and its licensors. All Rights Reserved. Unauthorized reproduction of the 
software is a violation of applicable copyright laws. 

The Sentry Spelling-Checker Engine  
Copyright © 2000 Wintertree Software Inc. 

 

 
 

Trademarks 
Memories Builder, Memories Builder DVD, Yearbook Interactive, and StoryRock logos are trademarks of 
StoryRock, Inc. 

QuickTime and QuickTime logo are trademarks used under license. The QuickTime logo is registered in 
the U.S. and other countries. All other company and/or product names are trademarks and/or registered 
trademarks of their respective manufacturers. 
 

Yearbook Interactive Technical Support 
877-463-6924 ext.23 (7am - 6pm M–F PST)  •  techsupport@ybi.com 
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How to Use Memories Builder DVD 
Version 2.1 
 

Getting Started 
This section of the User’s Guide contains instructions for installing Memories Builder 
DVD 2.1. To begin reading about the program, see Memories Builder DVD – Core 
Concepts on p. 6. 
 
Important: You will need to receive a portable hard drive from Yearbook Interactive 
before you can return your project to us for duplication. Contact your Customer Service 
Representative at least 30 days prior to submission to request one (877-463-6924 M-F 
7am-5pm PST).  
 

System Requirements 
Prior to installing Memories Builder DVD 2.1, ensure that your computer meets the 
following technical specifications: 
 
Windows: 
• Windows 2000 or XP 
• Pentium IV, 1 GHz (1.6 GHz recommended) or comparable AMD Athlon processor 
• 256 MB RAM (512 MB recommended) 
• 32 MB Video RAM (128 MB recommended) 
• Available Hard Disk Space: 15 GB or more 
Macintosh: 
• OS X 10.2.8 or greater (including the most recent updates for QuickTime and Java) 
• G4 700 MHz or Faster (1 GHz recommended) 
• 256 MB RAM (512 MB recommended) 
• 32 MB Video RAM (128 MB recommended) 
• Available Hard Disk Space: 15 GB or more 
• Power Mac G4 and G5; iMac flat panel; PowerBook G4; iBook G4; or eMac 
 

System Settings 
• Monitor Resolution: 1024 x 768 or higher. 
• PC Color Depth: High Color-16 bit. (True Color-32 bit recommended) 
• Mac Color Depth: Millions of Colors 
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Recommended Additional Equipment 
• Digital Camcorder 
• Movie Editing Software (e.g. iMovie, Adobe Premier, Muvee) 
• A microphone compatible with your specific computer 
• Speakers 
• Digital Camera 
• Photo Editing Software (e.g. Photoshop) 
• Audio Editing Software (e.g. Audacity) 
• Scanner 
 

Installation 
Note: In many cases, you will need to have your computer systems administrator install 
Memories Builder DVD using an administrator account (especially for Windows 2000). 
To read more, see Folder Access, Security, and Memories Builder in Appendix C. 
 
PC (Windows computer) Instructions: 
1. Insert the Memories Builder DVD 2.1 disc into your CD-ROM drive. 
2. The disc is programmed to auto run and will automatically launch a menu. If the disk 

does not automatically run, locate the CD from My Computer. Click with the right 
mouse button on the CD drive, and select Explore from the menu that pops up. In the 
new browse window, double-click on MBDVDMenu.exe.  

3. In the menu that comes up, click once on Install Memories Builder DVD. 
4. Allow the installation to keep the default settings and locations. If you need to do a 

custom installation, read each step carefully. 
5. When the installation is completed, the CD will check to make sure you have 

QuickTime installed on your computer. If you don’t, follow the instructions to install 
QuickTime. 

6. When installation has finished, close all installation windows. 
 
Mac Instructions: 
1. Insert the Memories Builder DVD 2.1 disc into your CD-ROM drive. 
2. Double-click on the CD-ROM image on your desktop to view its contents. 
3. Double-click the installation icon.  
4. Choose Applications for the location and allow the installation to keep the default 

settings. If you’re doing a custom installation, read each step carefully. 
5. When installation has finished, close all installation windows. 
 
Installation Notes: 
• Memories Builder DVD requires QuickTime to work properly. A QuickTime 

installer will be part of the full installation process.
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• Java 1.4.1 is required for the PC. Memories Builder DVD will install it automatically 
on Windows PCs (Mac computers will need to use Software Update if they do not 
already have Java 1.4.1). 

 

Project Creation Principles – Please Read 
Here we’d just like to point out a couple of things that will have a serious impact on your 
experience creating a DVD multimedia supplement. These items will help you avoid the 
most serious and catastrophic problems. These items are critical! 
 
• Do not delete your project prematurely. Keep your project and all related files 

(videos, images, audio) on your computer’s hard drive until you receive the finished 
product back from us and have ensured that everything is the way you want it to be. 
Please inform your computer system administrators about this to keep them from 
deleting your files. 

• Follow all Finalize Project steps. It is critical that you follow the steps in the 
Finalize Project menu before sending your project to Yearbook Interactive. The most 
critical of these steps is called Export for Submission, which will copy your project 
to a portable drive. This ensures that your project will have all of the necessary 
components when you send it. Please do not attempt to send project files before 
exporting. 

• Send a Final Submission Form. You must send a Final Submission Form with your 
project submission to Yearbook Interactive (contact your Customer Service 
Representative). Projects that do not come with a completed Final Submission Form 
will be delayed until one is received. 

• Always exit the program. Always exit the program before logging off your 
computer to avoid corrupting your project. 

• Ensure adequate hard drive space. Memories Builder DVD projects require 
serious amounts of hard drive space (up to 36 GB). Check your computer for free 
hard drive space on a regular basis. If you run out of space while you are building 
your project, you may lose all of your work. 
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Memories Builder DVD – Core Concepts 
This section of the User’s Guide presents the most important features of Memories 
Builder DVD and the DVD format. The second section of the User’s Guide contains 
information about the program interface, tool icons, and program menus. 
 
This section is organized as follows: 

DVD Concepts (p. 6) 
Overview of the Memories Builder DVD Structure (p. 8) 
Creating a New Project (p. 10) 
DVD Menus (p. 13) 
Menu Buttons (p. 15) 
Videos (p. 17) 
Slideshows (p. 18) 
Finishing Your Project (p. 28) 

 
The second section of the User’s Guide is organized as follows: 

Contents Window (p. 34) 
Project Workspace (p. 35) 
Program Menus and Toolbars (p. 37) 

 
 

DVD Concepts 
 
General Concept  
Understanding DVD presentations is key to creating a great project. This section contains 
basic information about DVD Video, the format the multimedia supplement uses.  
 

Navigation  
The navigation in a DVD multimedia supplement works like the navigation for movies 
on DVD. Viewers of the multimedia supplement will access submenus, slideshows, and 
videos by clicking on menu buttons. The menus, submenus, slideshows, and videos form 
a structure for the project that Memories Builder DVD displays in the Contents window 
on the left side of the program. 

Capacity 
A DVD project can hold either one or two hours of content in 99 titles (videos and 
slideshows), depending on the project setting you choose when creating a new project 
(see Creating a New Project on p. 10). 



Memories Builder DVD 2.1 – Core Concepts 

7 

Definitions 
Button  

An interactive area that users click on to access a submenu or launch a title. 
DV Format  

Digital Video format. This uncompressed format stores video with the highest 
quality, but also uses the most storage space. If disk space allows, save your videos in 
DV format to preserve as much quality as possible. 

DVD-Video 
The standard format for presenting movies on a DVD. When you rent a DVD from 
the video store, this is the format that the movie is in. 

Menu 
A navigation screen in DVD-Video. The viewer interacts with the menu by clicking 
on the buttons (or using a remote control on a DVD console player). The menu also 
includes a background image or movie and background audio. 

Menu Style 
Determines the appearance of menus, including the title font, menu button 
appearance and fonts, and background images. 

Motion Button 
A DVD menu button that shows a short preview of a video or slideshow as the button 
image. Clicking on the menu button will launch the full video or slideshow. In the 
menu, the preview video or slideshow repeats until the user makes a menu selection. 

Motion Menu 
A DVD menu that incorporates motion video as the background. The video is a short 
clip that repeats until the user makes a menu selection. 

Slideshow  
A sequence of timed still images. 

Title 
A video or slideshow in the DVD presentation. There is a limit of 99 titles in a DVD 
presentation. 

TV Safe Area 
Not all television sets display the full DVD picture (usually 5-10 percent of the 
picture will extend beyond the visible area of a TV screen). For this reason, text, 
menu buttons, and other essential objects must be within the area that is visible on all 
TV sets. This area is called the TV Safe Area. The TV Safe Area is the area in the 
middle of the workspace that is not covered by the semi-transparent gray. 
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Overview of the Memories Builder DVD Structure 
It is crucial to understand the structure of a DVD before beginning your project. A DVD 
is made of three types of content: Menus, Videos, and Slideshows.  
 
Menus (see top image at right)—DVD menus form the structure 
of your presentation and provide navigation for users. The Title 
Menu (top level menu) is the first thing that viewers will see when 
viewing the DVD. From this menu and submenus, a user clicks on 
a DVD menu button (the active area) to launch a video, slideshow, 
or submenu. A button can be a graphic, a still frame, or a motion 
preview of a video file or slideshow.  
 
Videos (middle image)—Videos are high-quality, digital movies 
that, most likely, will make up the largest portion of your DVD.  
 
Slideshows (bottom image)—A slideshow is what you would 
expect - a sequence of timed still images. With Memories Builder 
you can customize slideshows in a number of ways, including 
adding a background image, setting the time interval between 
slides, and placing images, custom shapes, and text on the slides. 
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Getting Familiar with the Memories Builder Workspace 
 
Memories Builder DVD User Interface 

 
 Contents Window – Shows the structure of the project 
 Project Workspace – Displays the menus and objects. This is where users will select 

and edit slideshow objects and menu names. 
 Program Menus and Toolbars – Contain Memories Builder DVD’s functions. The 

toolbars have icons for the most common functions. The gray area around the outside 
shows parts of the presentation that may not be visible when viewing the DVD on a 
TV. 

 Space Indicator – The green bar indicates how much of the project’s available space 
you have used. The numbers to the right indicate how many of the available titles 
(video clips and slideshows) you have used. 

 
For more detailed information on the Memories Builder DVD interface, see page 33. 
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Building Your DVD Project 
 

Creating a New Project 
The first step in building your DVD presentation is to create a project file. Memories 
Builder DVD creates a new project with a default menu style, which includes the menu 
title font, menu button appearance and font, and menu background. During the planning 
process you will have the opportunity to build a menu structure and create deadlines and 
assignments. 
 
Important: Your DVD project can contain up to 2 hours of content in up to 99 titles 
(videos and slideshows). Using motion menus and buttons will decrease the amount of 
content you can include. 
 

To create a new project: 
1. Click on the New Project icon. 

 
2. A dialog pops up, prompting you to choose a folder for your DVD project. Memories 

Builder DVD will save your project files in the folder you choose. We recommend 
using the default location in the DVDProj folder found in your Memories Builder 
DVD Version 2.1 folder. Choose a folder and click on the Choose button. 

3. A new dialog appears, prompting you to enter a name for your project. Type in a 
name and click OK. 

Planning 

Memories Builder will ask you whether you would like to plan the project. There are a 
few steps to planning the project: 
• Project quality setting 
• Create project structure (menus) 
• Assign menus and deadlines, estimate contents 
• Project plan summary (with option to print) 

Note: You may view, change, or fill in a project plan at any time, even if you decide not to plan at this 
point, by choosing Plan Project from the Modify menu. 

4. Click on the Plan button to begin the planning process. To begin work immediately, 
click on No Plan and proceed to DVD Menus (p. 13).  
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5. If you decide to plan, Memories Builder will prompt you to choose the project 
quality and length setting.  
• 1 Hour Setting - This setting produces the highest quality video. This is the 

recommended setting unless you are sure you have more than one hour’s worth 
of video footage and slideshow material.  

• 2 Hour Setting - This setting allows you to fit the most video onto a DVD. This 
setting produces average quality video and is not recommended if your DVD 
project will include video with a lot of action (e.g. sports) or low-quality source 
video (e.g. video transferred from a VHS tape).  

Click on a button to choose the project quality setting. You may change this setting at 
any time by choosing Preferences from the Edit menu. 

 
6. Now the Project Planning window will appear. In this first screen, you will create 

your project structure by selecting, moving, and creating menus. 
a. Check the box next to the name of any 

default menu you would like to use. 
Unchecked menus will not be added to 
your project (even if you created them). 

b. To add custom menus, click on the Add 
Menu… button. In the Add Menu 
dialog, choose a menu name. The menu 
will be created as a submenu of the 
currently selected menu unless you 
check the Create on main level 
checkbox. 

c. A menu with submenus will have a plus 
or minus symbol next to its checkbox. 
Click on the plus or minus symbol to 
expand or collapse the menu structure. 

d. The Select All, Select None, Select All In Menu, and Clear All In Menu buttons 
are there to help you choose your menus more quickly or clear everything out. 

e. To reorder menus, click on a menu name and hold the mouse button down as you 
drag the menu up or down. 

f. When you have finished, click on the Next button. 

7. The next screen prompts you to choose the date you need to receive your project 
back from Yearbook Interactive. Click on the drop-down menus to select the date. 
This screen will show you other deadlines related to your project. Pay careful 
attention to these dates. If you do not complete the tasks by the date listed, Yearbook 
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Interactive may not be able to ship your final discs on time (see Finishing Your 
Project on p. 28 for more details).  

 
8. The next screen is for assigning portions of the project to students and setting 

deadlines and expectations for project contents. 

 
a. Fill in the Assigned to and Deadline fields for each menu. Navigate through the 

menus by clicking on the blue arrows (PREV and NEXT). 
b. Click on the Add Title button to add video clips and slideshows to the plan for 

each menu. Fill in the information for each title, including an approximate length. 
c. The Project Totals area will show you how much of the available project time 

and titles you have planned. 
d. If you need to add more menus, click on the Back button twice to get back to the 

menu structure screen. Return to the Assignments screen when finished. 
e. When you have finished all of your assignments, click Finish. 

9. The final screen shows you a summary of the Project Plan. There are a number of 
informative reports you can print. Choose the type of report by selecting an option 
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under Sort Report By and click on Print Report to print the Project Plan summary. 
Click Finish to exit the Project Plan.  

 
Memories Builder will now create your project. 
 
 

DVD Menus 
The following functions allow you to set up and modify the structure of your 
presentation. 
 

To create a new menu: 
1. Select a menu in the Contents window (the left pane). 
2. Click on the New Menu icon from the Contents Tools (above the Contents window). 

 
3. Choose a name for the menu in the new menu dialog. 
4. Click OK. Memories Builder DVD creates the menu as a submenu of the current 

menu and displays its button on the workspace. 
 

To change the name of a menu: 
1. Double-click the menu name in the Contents window (the left pane) or in the 

workspace. 
2. Type the new name of the menu in the rename dialog. 
3. Click OK. Memories Builder DVD updates the menu name. 
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To change a menu style: 
Memories Builder creates new projects with a default style, which you may change.  
Important Note: Changing a menu style will also change the menu style for all 
submenus, unless you have already chosen a custom menu style for the submenu. As an 
example, a project has a menu titled Sports with three submenus (Baseball, Basketball, 
Hockey). The Sports menu is using the Blue Bubble menu style. The Hockey submenu 
has been customized to use Gold Hollow. If an editor changes the Sports DVD menu 
style to White Classic Oval, the Sports menu, Baseball submenu, and Basketball 
submenu will all change. However, the Hockey submenu will retain its original 
customized menu (Gold Hollow). 
1. Click on the Menu Style icon (top icon bar). 

 
2. Click on one of the options from the pull-down 

menu, as shown at right. 
3. Memories Builder DVD updates all of your 

project menus with the new style choice. Any 
custom menu background images you are using 
will remain unchanged. 

 

To move (reorder) menus and other objects: 
1. In the Contents window click and hold down the mouse on the name of the menu or 

object you would like to move. 
2. Drag the object to a new position. A light gray line will show where the object is 

currently moving. 

 
3. Release the mouse button to place the object in its new position. 
4. Note: To move an item inside a menu, drag it over the top of the menu icon and then 

start moving the mouse to the right until a dark, right-pointing arrow appears. 
Release the mouse button. 

 

To change a menu background: 
1. Double-click on the menu background. 
2. Change the background image by clicking on the blue Memories Builder 

Backgrounds Library icon next to the Background field. To choose your own image 
or a video file, click on the yellow open folder icon. If you choose a video file, the 
menu will become a motion background (see below). 
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3. Browse to the image file you would like to use in the File Preview window. Click 
once on the file to select it and click Open. 

4. Click OK in the Menu Background Properties window to apply the change. The new 
background will affect the selected menu only. 

For more background image options, see the Menu Background Properties icon 
description on p. 39. 
 

To create a motion (video) background: 
Motion backgrounds allow you to have a looped video segment instead of a background 
image. Note: Using a large number of motion backgrounds will dramatically increase the 
size of your project and may limit the amount of content you can use.  
1. Select a menu in the Contents window. 
2. Double-click on the background of the menu (or use the Menu Background 

Properties icon – see p. 39).  
3. Click on the yellow open folder icon (top right). Browse to a video file, select it, and 

click Open. In the Menu Background Properties box, click OK. 
4. A frame of the background video shows up as the background of the menu, and the 

menu automatically becomes a motion menu. This change applies only to the 
currently selected menu. 

5. By default, the menu will loop the entire video or its first 60 seconds, whichever is 
shorter. The motion menu loop length is also determined by the maximum loop 
length setting (see below). 

 

To set the maximum loop length for your project’s menus: 
1. To change the maximum loop length for motion backgrounds, motion menu buttons, 

and background audio, click on the Menu Loop Length icon. 

 
2. Drag the slider to choose a length for the loop. 

 
3. Changing the Menu Loop Length will set the maximum length for all menus 

(including motion backgrounds and buttons). 
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Menu Buttons 
A menu button is an interactive area that viewers click on to access a submenu or launch 
a title (video or slideshow). Buttons that launch submenus are a fixed graphical icon. 
Buttons that launch titles show a preview of that title. The preview may be a static frame 
or a short motion preview loop. 
 

To add a button: 
Memories Builder will automatically add buttons when you add a new menu, video, or 
slideshow to the project contents. See Contents Window on page 34. 
Note: Adding more than six contents items to a menu will push the new contents items 
over to a new menu page. To access different menu pages, double-click the right or left-
pointing arrow icon in the bottom right corner of the workspace. 
 

To delete a button: 
Click on the button in the workspace and hit the delete key. 
 

To change a menu button’s appearance: 
Click on the button on the workspace. The Button Tools appear in the toolbar just above 
the workspace. 

 
• If the button is a slideshow or video button, clicking on the first icon brings up a 

slider that allows you to choose which slide or video frame to display in the button 
preview. 

• Clicking on the right-most icon brings up the Menu Title/Button Font dialog, which 
allows you to change the font for the menu buttons or title. Note: Font settings for 
buttons are global; changing the font settings will change the font for all buttons in 
the project. 

Note: The location of menu buttons is not adjustable. However, the button image itself 
can be changed by changing the style (see To change a menu style on p. 14). 
 

To enable or disable motion buttons: 
By enabling motion menu buttons, buttons that link to a video or slideshow will show a 
short preview loop of the video or slideshow. Enabling motion buttons makes all menus 
motion menus. Note: Motion menus dramatically increase the size of your project and 
may limit the amount of content you can use. By default, motion buttons are disabled. 
1. Click on the Motion Buttons icon. 
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2. The icon highlights and changes to the state indicating motion menu buttons. 

 
3. Clicking the icon will toggle between motion and static states. 
 

To choose the preview frame and start point for a specific button’s video or 
slideshow preview loop:  
1. Click on a menu, slideshow, or video button to select it. 
2. Click on the Button Start Point icon. 

 
3. Drag the start point slider that appears until you see the video frame or slide that you 

want to use for a start point in the menu button. 

 
4. Once you have made your selection, close the pop-up slider. 
 
 

Videos 
Videos are the real focus of the DVD presentation. Due to its high resolution, the DVD 
presentation may reveal imperfections in your source video. To avoid this, always use the 
highest quality source video possible. 
Important: Many programs have both a Save Project and Export (or Make Self-
Contained) option. Use the Export or Make Self-Contained option to avoid problems 
during the Export for Submission process. 
 
Here are our recommendations for your video files: 
Format: DV (uncompressed) format. The method for selecting this format depends on 
your video editing program (see bullet points below).  
Note: Playback of uncompressed video requires more processing power and system 
resources than many computers can provide. Playback may be choppy on some machines. 
Yearbook Interactive will compress the video as part of the DVD encoding process, 
allowing video in the final product to play smoothly on computers and TV set-top DVD 
players. 
 
• In iMovie, use the Full DV setting. This is available by choosing to export to 

QuickTime, and then choosing Full Quality DV from the Format drop-down.  
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• In Windows Movie Maker, choose Save Movie from the File menu. Choose Other 
from the Setting drop-down and DV-AVI NTSC from the Profile drop-down. 

• In Adobe Premiere, choose Export and then Movie from the File menu. Click on the 
Settings button in the Save dialog. Click on the Next button in the Export Settings 
window. Choose DV/DVCPRO – NTSC from the Compressor drop-down and enter 
720x480 in the Frame Size boxes. Click OK and save the file. 

• In QuickTime Pro, choose Movie to DV Stream from the Export pull-down in the 
Export dialog. 

• In Pinnacle Studio, choose the Make Movie tab, click on the AVI button on the left, 
click on the Settings button, and choose DV Video Encoder from the drop-down 
menu. 

 
In some cases, you will still need to choose a few settings before exporting your video. 
Other Recommended Settings (if necessary): 
Frame Size: 720x480 
Frames Per Second: 30 
Sound Settings: Uncompressed, 44,100 Hz sample rate, 16 bit resolution, stereo. 
 
For a summary of the overall video process, see Preparing Video on page 50. 
 

To place a video in the DVD presentation: 
1. Select a menu in the Contents window (the left pane). 
2. Click on the New Movie icon in the Contents toolbar. 

 
3. Browse for the movie file and click on it. The preview pane in the left part of the 

browse dialog allows you to see the movie before adding it to your presentation. 
4. Double-click on the video file in the file preview dialog or click Open to add the 

movie to the current menu. 
 
 

Slideshows 
These functions allow you to create, remove, and reorder slides. They also allow you to 
place and modify images, text, and shapes on slides. 

When you select a slideshow in the Contents window, Memories Builder DVD will 
display the first slide in the project workspace. A timeline of the slides in the slideshow 
will appear below the workspace with thumbnails of each slide. 

Note: Slideshows are limited to 99 slides per slideshow. 
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Editing a slideshow 

 
 Slide Tools – Access general functions for editing slideshows with these icons. 
 Project Workspace – Click on slideshow items in the workspace to move, resize, and 

edit them. 
 Timeline – Use this to see the slide order and to reorder, delete, and add slides. The 

buttons to the left of the timeline allow you to add, hide, and delete slides. 
 
Slideshow Functions: 
To create a new slideshow (p. 19) To crop a slideshow image (p. 22) 
To add a slide to a slideshow (p. 20) To automatically build a slideshow (p. 23) 
To select a different slide for editing (p. 20) To add text to a slide (p. 24) 
To change slide order (p. 20) To create a shape (p. 25) 
To add an image to a slide (p. 21) Slideshow Properties (p. 25) 
 

To create a new slideshow: 
1. Select a menu in the Contents window (the left pane of Memories Builder). 
2. Click on the New Slideshow icon. 

 
3. Type a name for the slideshow in the new slideshow dialog box and click OK. 

Memories Builder DVD creates the new slideshow, which will appear as an item in 
the current menu in the Contents window. 

4. Click on the name of the slideshow in the Contents window. The project workspace 
now shows the first (blank) slide of the slideshow. 
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To add a slide to a slideshow: 
1. With a slideshow selected, click on the New Slide icon from the Slide Tools. 

 
2. Memories Builder DVD creates a new slide at the end of the slideshow. 
3. To add slides with a template, click on the New Slide from Template icon. 

 
4. After clicking on the icon, Memories Builder will present a list of templates. 

 
5. Click on the name of a template to see a preview of the template. Click OK to select 

a template and add the new slide. 
6. Memories Builder will now remember the template you have selected. Any new 

slides you add with the regular New Slide icon will use this template. To change 
templates, use the New Slide from Template icon. 

7. You may also add or insert slides by right-clicking (Ctrl-click on the Mac) on a slide 
thumbnail in the timeline (below the project workspace) and choosing Insert After or 
Insert Before. 

 

To select a different slide for editing: 
1. Click on a slide thumbnail in the timeline (below the project workspace). 
2. Memories Builder DVD displays the slide in the project workspace for editing. 
 

To change slide order: 
1. Click on the thumbnail in the timeline of the slide that you would like to move and 

hold down the mouse button. 
2. Drag the slide to its new position (indicated by the solid black vertical line). 
3. Release the mouse button to place the slide. 
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To add an image to a slide: 

Slide with Template 
1. Double-click on a template box. 
2. Browse to an image file (JPG, BMP, PNG, GIF, TIF, PIC), select it, and click Open. 

 
3. The image will appear in the Image Editor box.  

 
• The rotate buttons make it easy to correct images that were taken in different 

orientations (portrait and landscape) so that everything is right side up. The left 
button rotates the image 90° counter-clockwise, and the right button rotates it 90° 
clockwise. 

• Zoom in or out with the magnifying glass icons and drag the image around to fit 
the template box.  

4. After adjusting the image, click OK. The image will now replace the template box on 
the slide. 

Blank Slide 
1. With a slide selected, click on the camera icon from the Slide Tools. 
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2. Browse to an image file (JPG, BMP, PNG, GIF, TIF, PIC), select it, and click Open. 

 
3. The mouse pointer becomes a crosshair. Position the crosshair to 

place the image on the slide. Click once on the slide to place the 
full-sized image, or click and hold the mouse button down and 
drag the mouse to open up a placement rectangle, as shown at 
right. Memories Builder DVD will display the dimensions of the placement rectangle 
on the bottom bar as you drag. 

4. After releasing the mouse button, Memories Builder DVD will place the image. 
 

To crop a slideshow image: 
1. Click on an image to select it. 
2. Click on the Crop icon from the Image Tools (just above the Workspace). 

 
3. The Crop window opens with the image in it. The mouse cursor becomes a crosshair. 
4. Position the crosshair, click and hold the mouse button down while dragging the 

mouse to define a crop region, and release the mouse button. 

 
5. You can drag the crop region around by clicking on it and holding the mouse button 

down as you move the mouse. You can also increase or decrease the crop region size 
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by clicking on the gray box at the bottom right corner of the crop region and holding 
the mouse button down as you move the mouse. 

6. When you are satisfied with your crop region selection, click on the Accept button. 
The grayed out parts of the image will be deleted.  

 

To automatically build a slideshow: 
Auto Slide Builder is a tool that will create a slideshow of up to 99 slides from the images 
you select. The tool will automatically create slides as needed and place the selected 
images using layouts that you specify. 
 
1. Click on a slideshow in the Contents window or create a new slideshow (see p. 19). 
2. Click on the Auto Slide Builder icon. 

 
3. The Auto Slide Builder dialog appears.  

 
• Click on the Add button to browse to your images. In the file browse window, 

double-click folders to open them and click once on files to select them. 
• Select multiple files in sequence by clicking on the first file and then Shift-

clicking on the last file.   
• Select multiple random files by using Ctrl-click (Apple-click on the Mac). 
• You may also select entire folders by clicking once on the folder name. 
• After selecting images, click on the Open (Choose on the Mac) button. 
• You may click on the Add button multiple times to continue adding images from 

different locations to the list. 
• Click on an image to see a thumbnail of it in the Preview area. 
• Click on the Remove button to take the selected image out of the list of files to 

use for Auto Slide Builder. 
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• Checking the Drop shadows box will add a shaded area behind the image to give 
it the illusion of depth on the slide. 

• Checking the box next to Randomize templates will make Memories Builder 
choose from the templates you have selected in random order when creating new 
slides (by default, Memories Builder will use the templates in order). 

• Clicking on the Choose Templates button brings up a new dialog which displays 
previews of the slide templates that Auto Slide Builder will use when creating 
slides.  
- Check the boxes next to the templates you would like to use. Click Select All 

to use all slide templates or Deselect All to clear the current selection. 
- When finished, click OK (at least one template must be selected). 

4. After choosing the Auto Slide Builder options, click Start. Memories Builder DVD 
will begin creating slides and placing images. When the progress bar indicates that 
Auto Slide Builder is finished, click the Close button to return to the slideshow. 

5. Click on the slides in the timeline bar to preview and edit the new slideshow slides. 
 

To add text to a slide: 
General Suggestion: Text will not be as clear on a TV as on a computer. To compensate, 
use high contrast colors, bold fonts and large font sizes (at least 18 point), and avoid 
putting any text outside the TV Safe Area (see Definitions on page 7). 

To add captions, titles, or stories:  
1. Select a slideshow. 
2. Click on the Text icon or choose Add Text from the Insert menu. 

 
3. The Font Style Chooser dialog will pop up. It provides a number of options for the 

text. 
a. Font face – a set of printable or 

displayable text characters in a 
specific style. 

b. Font size – determines how large 
the characters are. Choose from the 
list or type in a number. 

c. Font style – allows emphasis of 
words using bold, underline or 
italic styles. 

d. Font alignment – determines the 
justification of the text inside the 
text box. 

e. Font color – changes the text color 
for the selected words or characters. 
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Click on a color on the color palette or click on More Colors… to open the Font 
Color Chooser (see Color Chooser below for more information). 

f. Preview box – shows how the text will appear on the page. 

4. Type text in the text preview area. To change style elements after typing in the text, 
highlight the portion of the text to change (any portion may be selected and changed 
independently of the rest of the text) and choose the style change. 

5. Click OK when finished. 
6. When returning to the slide, click and hold the mouse button down and drag the 

mouse to open up a placement rectangle. The text appears in a box that can be moved 
or resized like any other object. The text tool bar above the workspace provides 
access to a number of text functions. For more information on text, see Text Tools on 
page 45. 

 

To create a shape: 
1. Select a slideshow. 
2. Click on the Add Shape icon from the Slide Tools (top right).  

 
3. The shape drop-down menu appears. Choose a shape from the drop-down menu. 
4. Position your cursor in the workspace, click the mouse button, and hold down. 
5. Drag out an area to define the size of the shape. 
6. When you release the mouse button, Memories Builder places the shape on the slide. 

See the sections starting with To move a slideshow object on p. 36 and the Shape 
Tools section on p. 43 for more information on shapes. 

 

Slideshow Properties 
The Slideshow Properties dialog contains features that affect the entire slideshow, 
including slide time interval, transitions, background music, and background image.  It 
also contains information on the total number of slides in the slideshow and its length. 
 
To open the Slideshow Properties dialog, select a slideshow in the Contents window and 
click on the Slideshow Properties icon. 
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The Slideshow Properties dialog appears: 

 

Slide Interval 
• Sets the length of time each slide is displayed. Drag the slider to change the time 

interval (in seconds). Two seconds is the minimum interval (to give viewers enough 
time to see each slide). 

• Check the Manual Slideshow box to make the slideshow a manual slideshow, which 
cannot have dynamic features like audio and transitions. Instead, the user will decide 
when to advance to the next slide using the remote control. 

• Check the Fit slideshow to audio length box to have Memories Builder DVD set a 
time interval per slide that will allow the total slideshow length to match the length of 
the slideshow’s audio file (see Slideshow Audio below).  
Note: A minimum interval of two seconds per slide is required. If fitting the 
slideshow to the audio length would set the slide interval to less than two seconds per 
slide, Memories Builder will force the interval to two seconds and the audio will stop 
playing before the slideshow has finished. 

• The slideshow length box shows the total number of slides and the slideshow 
duration (based on the number of slides multiplied by the slide interval). 

Slideshow Audio 
The Slideshow Audio feature allows you to choose an audio file to play in the 
background as users view the slideshow. 
• To include background audio, click on the Memories Builder Library icon (the blue 

folder on the left) to use the music that comes with Memories Builder, or click on the 
open folder icon to browse for your own audio file. 
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Note: Slideshow audio can loop if you check the box next to Loop audio. If you do 
not loop the audio file, ensure that the length of the audio file is equal to or greater 
than the length of your slideshow if you want audio to play for the entire slideshow. 

• Select an audio file and click Open. The audio file is assigned to the slideshow. 
• Click on the Play button to listen to the audio file. 
• Click on the Clear button to remove the slideshow audio file. 
• If you decide not to use background audio, check the Don’t play audio selection box 

(you can also use this checkbox to compare the slideshow in preview with and 
without the audio file without removing the file from your project). 

Transitions 
• A transition is a visual effect between adjacent images. It can make the change to the 

new image smoother or more interesting. 
• Choose a transition from the pull-down menu (Cut is equivalent to no transition). The 

final product will use the selected transition between slides.  

Background 
A background image displays behind all other objects on every slide of the slideshow. To 
add or change a slideshow background image, click on the Background tab. 

 
• To set the background image, click on the Memories Builder Library icon (the blue 

folder on the left) to use the images that come with Memories Builder, or click on the 
open folder icon to browse for your own image file. 

• When you have selected and previewed your background image, click Open. Note: If 
the image is not 640x480 pixels in size, it will be stretched to fit the workspace. 

• Drag the Background Image Opacity slider to change the contrast of the background 
image. 

• If you decide not to use a background image, check the Don’t display custom 
background box. 

• Click OK to close the Slideshow Properties box and apply any changes. 
 
See the Project Workspace section on p. 35 for other slideshow functions, such as editing 
images and shapes. 
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Finishing Your Project (Finalize Project Menu) 
The Finalize Project menu contains the final steps required to prepare your project for 
submission. Call a Customer Service Representative early in the school year at 877-463-
6924 to ensure that you meet the schedule deadlines and to get your portable hard drive. 
 

Step 1: Preview Project 
Preview mode presents your project the way users will see it. You may use preview at 
any time to see what your project will look like to users. To ensure that everything in 
your project is just the way you want it, preview the entire project before sending it 
to Yearbook Interactive. 
 
Choose Step 1: Preview Project from the Finalize Project menu or click on the eye icon 
on the toolbar. Memories Builder DVD will now display your project as viewers will see 
it in the final product, starting with the Title Menu.  
Note: By default, motion menus and buttons are not displayed in preview mode (for the 
purposes of speed), but will be activated in the finished DVD. To see motion, see p. 32. 

 
 
The graphic remote control on the left side of the screen is provided to emulate the 
handheld remote control used with a DVD player. It controls the navigation and playback 
of the presentation. 
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Menu Navigation Buttons move the cursor around to different menu items in the 
direction indicated. Click on the Select button to launch menu items. 
Previous/Next Slide Arrows move to the previous or next slide when viewing a 
slideshow. 
Fast Forward/Rewind Buttons advance or rewind a video clip. 
Menu Shortcut Buttons jump to menus. Click on the Title button to return to the 
presentation’s main menu. Clicking on the Menu button while viewing a video or 
slideshow returns you to its parent menu. 
Menu Item Play Controls stop, pause, or resume playback of a video or slideshow. 
 
Click on the Exit Preview button when you have finished previewing your project. 
 

Step 2: Check Project for Errors 
This step searches the project for problems and displays a list of anything it finds. This 
function primarily searches for corrupt objects and missing files. 
 
Choose Step 2: Check Project for Errors from the Finalize Project menu. Memories 
Builder DVD will generate a report of any errors it finds. Errors are listed under the name 
of the menu item where the problem exists. 
 
Common Errors: 
<Type of File> does not exist in project folder – If you receive this error, it is because an 
object file (video, slideshow image or text) is missing. Locate the object in the menu that 
the error indicates (video files will be replaced by a blank, white background, slideshow 
images by a blue box, and slideshow text by a yellow box). For video files, select the 
object and delete it. Then replace the object with the original file. For slideshow objects, 
double-click on the blue or yellow box to browse for the original image file or re-enter 
the original text. 
Image Rectangle is off canvas (Slideshow) – This error indicates that an image has been 
pushed off the edge of a slide. Select the image and move it back onto the slide. 
Text exceeds boundaries of text box (Slideshow) – This warns you that not all of the text 
in a text box may be visible. Make the box larger to show all of the text. 
 
If you have questions, contact Yearbook Interactive Tech Support at 877-463-6924 x23. 
 

Step 3: Check Spelling 
Choose this menu item to have Memories Builder DVD check the text boxes in your 
project for misspelled words. The Spell Checker will notify you of anything it finds. 
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Step 4: Export for Submission 
The final step before sending a project to Yearbook Interactive is the Export for 
Submission process. Errors or problems with the Export for Submission process may be 
difficult to solve. Call Tech Support toll-free at 877-463-6924 x23 for assistance. 
Your project will be too large to send on CD. So, before you can export your project, you 
will need a portable hard drive that Yearbook Interactive will send to you. Call 877-463-
6924 and ask to speak to a Customer Service Representative for assistance. 
 
1. Ensure that the portable hard drive is connected to your computer before beginning. 

Double check to make sure it has power and shows up in My Computer (Windows 
computer) or on the desktop (Mac). Memories Builder DVD will copy all of your 
project files to the portable hard drive in preparation for sending your project to 
Yearbook Interactive.  

2. Choose Step 4: Export for Submission from the Finalize Project menu.  
3. Memories Builder DVD will begin copying files to the portable drive. Important 

Note: This process could take a long time (more than an hour in some cases). 
4. During the Export for Submission process, Memories Builder DVD will display error 

messages if there is something wrong with the project. 
5. Memories Builder DVD will inform you when the process is complete. Do not log 

out or shut down your computer until the Export for Submission process is complete. 
 

Submit the Project 
• After disconnecting the drive, send your project back to YBI for production and 

duplication. Make sure it arrives before your project due date. 
• Do not delete the project from your computer until you have received and 

distributed your final discs. 

To mail the compiled project:  
1. Fill out a Final Submission Form (contact your Customer Service Representative) 

and include it with the hard drive.  
2. Package the hard drive in the box you received it in. Please include all cords and 

other items that came with it. 
3. The shipping label that is included with the portable hard drive is UPS 3-day. Allow 

at least 3 business days for delivery of the hard drive. 
4. Affix the enclosed shipping label over the original shipping label, tape up the box, 

and drop it off at a UPS office or drop box. 
5. Yearbook Interactive will return your finished DVDs to you within 30 days of 

receiving the portable hard drive. 
 
Contact a Yearbook Interactive Customer Service Representative for any further 
questions about mailing your project to Yearbook Interactive at 1-877-463-6924. 
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Project Preferences 
The Preferences dialog allows you to change settings that will affect the whole project. 
To access the Preferences dialog, choose Preferences from the Edit menu. 
 

Project Mode 
The Project Mode setting affects the amount of content you can include in your project 
and the quality of video in the final product. 

 
• 1 Hour Setting - This setting produces the highest quality video. This is the 

recommended setting unless you are sure you have more than an hour’s worth of 
video footage and slideshow material.  

• 2 Hour Setting - This setting allows you to fit the most video onto a DVD. This 
setting produces average quality video and is not recommended if your DVD project 
will include video with a lot of action (e.g. sports) or low-quality source video (e.g. 
video transferred from a VHS tape).  

Click on a button to choose the project quality setting. You may change this setting at any 
time. 
 

Grid Size 
Clicking on the Grid Size tab brings up the grid setting. 
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The grid displays as a backdrop on slideshow slides to assist you in aligning objects, as 
shown below. It must first be enabled. Choose Snap to Slideshow Grid or Show 
Slideshow Grid from the Modify menu (see p. 47 for more info). 

 
To change the distance between the grid lines, drag the slider. 
 

Preview Settings 
The Preview Setting tab brings up the options for showing motion in Preview mode. 
 
A DVD menu can have two different types of motion: 
Motion Button 
A DVD menu button that shows 
a short preview of a video or 
slideshow as the button image. 
Clicking on the menu button will 
launch the full video or 
slideshow. In the menu, the 
preview video or slideshow 
repeats until the user makes a 
menu selection. 
Motion Menu 
A DVD menu that uses a video 
file as the menu background. 
The video is a short clip that 
repeats until the user makes a 
menu selection. 
 
Previewing a project with both motion menus and motion buttons enabled is processor-
intensive, and may result in choppy or stuttered playback. In order to see playback 
smoothly, choose a setting that your computer can play without choppiness. 
Note: The final DVD will be optimized to play smoothly on any DVD player. 
 
Click on a button next to one of the options. You may change this setting at any time. 
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Program Interface 
 
Memories Builder DVD User Interface 

 
 Contents Window (p. 34) – Shows the structure of the project. This is the primary 

area for working with menu items (select, rename, move, delete).  
 Project Workspace (p. 35) – Displays the menus and objects. In this area users will 

select and edit slideshow objects. 
 Program Menus and Toolbars (p. 37) – Contains Memories Builder DVD’s 

functions. The toolbars have icons for the most common functions. 
 Indicators – DVD-Video is limited to 60 or 120 minutes of content (see Project 

Preferences) in 99 titles (movies or slideshows). To help you keep track of your 
project’s size, Memories Builder displays a Space Indicator Bar and a Title Counter. 

 
Space Indicator 
The space indicator is located at the bottom-left of the Memories Builder DVD 
application. The green progress bar will move from left to right based on how much data 
and/or time your DVD elements will require on the final DVD. If the progress bar begins 
to show red, you have reached the full capacity of your DVD. 
 
Title Counter 
The Title Counter, located just to the right of the Space indicator, displays the number of 
titles currently found in the project. The number of titles used is shown in relation to the 
maximum number of titles allowed. (E.g. If you were to include 5 movie clips and 3 
slideshows, you would have 8 titles. The Title Counter would display: 8/99 titles.)
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Contents Window 
This area of the program interface displays the structure of your DVD presentation. It 
also allows you to edit the structure by selecting, renaming, moving, or deleting items. To 
add new items to the contents of your project, use the Contents Tools (see p. 38). 
 

To select a menu, video, or slideshow: 
1. Locate the name of the item in the Contents window and click on it once. 
2. The workspace updates to display the menu, video, or slideshow. 
 

To change the name of a menu, video, or slideshow: 
1. Locate and double-click on the name of the item in the Contents window. 
2. Type a new name in the box that appears and click OK. 
3. Memories Builder DVD updates the name of the item. 
 

To move (change the order of) menu items: 
1. Click on the name of the item you would like to move in the Contents window and 

hold the mouse button down. 
2. Drag the item to its new location (a light gray line will show where the item is 

moving) and release the mouse button. 
3. Note: To move an item to a submenu, expand the destination submenu in the 

Contents window by clicking on the plus symbol (right-pointing arrow on the Mac) 
next to the submenu name. 

4. To move items into a menu, drag it over the menu 
icon and move the mouse to the right until the 
right-pointing arrow appears and then release. 

 
 

To delete an item in the Contents window: 
1. Right-click (Ctrl-click on the Mac) on the name of the item to delete. 
2. Choose Delete from the menu that appears. 
 
For more information regarding the Contents window, see Contents Tools (p. 38) under 
Program Menus and Toolbars. 
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Project Workspace 
The project workspace allows for navigation and basic project editing, such as renaming 
a title and slideshow functions (moving and resizing slideshow objects). 
 

To navigate the project: 
• Double-click on menu buttons to open and edit menus in the workspace. 
• Double-click on the home or up icons in the lower left corner of the workspace to 

return to the title menu or the current item’s parent menu, respectively. 
 

To rename a menu title on the workspace: 
1. Double-click on the title. 
2. Type a new name in the box that appears. 
3. Click OK. 
 

To customize a button: 
Buttons can be customized in a few different ways, depending on the type of button. The 
type of the button is determined by what it links to (a menu, video, or slideshow). 

Menu button appearance (the border or frame of the button) is determined by the menu 
style. To change menu button appearance, choose a different menu style (see p. 14). 
 

To change the button font (any button type): 
Note: This change will affect all buttons in menus for which you haven’t yet chosen a 
custom DVD style. 
1. Click on a button. The Button Tools icons appear just above the project workspace: 

 
2. Click on the Menu Fonts icon (the icon on the right). The Fonts dialog will appear 

with the Buttons tab selected. 
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3. In the Fonts dialog, choose the font face, size, style, and color for the button fonts. 
Click OK when you have made your selection. 

4. Memories Builder will update all menu buttons with the new font selection. 
 

Other Customization Options: 

Menu Button 
• No customization possible. 

Video Button 
• Click on the video button. A toolbar appears just above the project workspace. 
• Click on the Button Start Point icon (the icon on the left). Drag the slider around to 

choose which part of the video to display in the button. If motion buttons are enabled 
(see p. 16), the slider will set the start point for the video loop.  

Slideshow Button 
• Click on the slideshow button. A toolbar appears just above the project workspace. 
• Drag the slider around to choose which slideshow slide to display in the button. If 

motion buttons are enabled (see p. 16), the button will loop the slideshow, starting 
with the point in the slideshow you chose with the slider. 

 

To move a slideshow object: 
1. Select the object to move by clicking on it and holding down the mouse button.  
2. While holding the mouse button and dragging, the item may be placed anywhere on 

the slide. A light gray outline of the object will move around the slide to assist in 
placing the object. 

3. Release the mouse button to place the object in its new location. 
 

To resize a slideshow object: 
1. Click on the object. Small gray boxes appear around the edges of the object. 
2. Click and hold one of the gray boxes while dragging the mouse. 
3. Side boxes resize the object in one dimension (horizontally or vertically), while 

corner boxes allow you to resize objects in both dimensions (images and shapes will 
retain their aspect ratio, text will not). 

4. When you have resized the object, release the mouse button. Memories Builder DVD 
will update the object in the project workspace. 

 

To delete a slideshow object: 
Click on the object and hit the Delete or Backspace key, or choose Delete Object from 
the Edit menu.
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Program Menus and Toolbars 
Memories Builder toolbars contain icons for the most common program functions.  

 
 General Tools – Basic program functions like opening and saving projects, cut, copy, 

paste, and undo/redo. 
 Contents Tools – Adding and deleting project contents. 
 Workspace Tools – Functions that relate to the workspace (menus, slideshows, etc.). 
 Objects Tools – Functions that relate to editing the currently selected object. 

 
The Program Menus subsection starts on page 46. 
 
 

General Tools 
This unchanging set of icons provides access to the most common project functions. 
 

 

Icon Descriptions: 
1. New Project – Begins the process for creating a Memories Builder DVD project (and 

closes the current project). 
2. Open Project – Provides access to Memories Builder DVD projects through a browse 

window. 
3. Save – Saves (writes the project to disk) in the current or default location with the 

current filename. The default location is in the Memories Builder DVD folder inside 
a folder named Projects. 

4. Preferences – Opens the Preferences dialog, which includes settings for Project 
Quality Mode, Grids, and Preview motion. See Project Preferences on p. 31. 

5. Preview Project – Shows the current project in a mode that simulates the final DVD 
product. 

6. Show Safe Area – Hides or displays the semi-transparent gray overlay that indicates 
which part of the workspace is most useful for critical images, text, and navigation 
(not all of the workspace will appear on a typical TV screen. See TV Safe Area in 
Definitions for more information). 

7. Cut – Moves a slideshow object to the clipboard to be pasted in another location. 
8. Copy – Copies a slideshow object to the clipboard to be pasted in another location. 



Memories Builder DVD 2.1 – Program Menus and Toolbars 

38 

9. Paste – Applies the slideshow object stored in the clipboard to the current slide. You 
may also paste a cut object by clicking with the right mouse button (Ctrl-Click on the 
Mac) and choosing Paste from the menu that appears. 

10. Undo – Cancels the last slideshow edit. 
11. Redo – Reverses the undo operation. 
 
 

Contents Tools 
The Contents Tool icons are for adding and deleting Contents window items. 
 

 

Icon Descriptions: 
1. New Menu – Creates a menu as a submenu of the currently selected menu. 
2. New Video – Opens a browse window for selecting a video to add to the current 

menu. 
3. New Slideshow – Creates a slideshow in the currently selected menu. See p. 19. 
4. Delete – Permanently removes the currently selected item from the menu. If the item 

is a submenu, Memories Builder DVD will delete all of its sub-objects as well. 
 
 

Workspace Tools (Menu, Slide, and Video Tools) 
The functions available through the Workspace Toolbar change according to what the 
workspace is displaying. The three available tool sets are Menu Tools, Slide Tools, and 
Video Tools. 
 

Menu Tools 
The Menu Tools are for customizing the look of project menus. Tools include functions 
for choosing and customizing menu styles, background image or movie, and background 
audio. To access this tool set, select the menu you wish to customize in the Contents 
window. The following tool icons appear on the top icon bar next to the General Tools: 
 

 

Icon Descriptions: 
1. Menu Styles – Provides choices for changing the menu style, which determines the 

appearance of the menu, including button appearance and default background image, 
title font, and button font. 
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2. Menu Background Properties – Opens the Menu Background Properties dialog, 
which allows you to modify the menu background in the following ways: 
• Change the background image by clicking on the blue Memories Builder Library 

icon next to the Background field. To choose a custom image or a video file, 
click on the yellow open folder icon. Choosing a video file will make the menu a 
motion menu – a short segment of the video will loop in the background of the 
menu until the user makes a selection. Note: By default, motion backgrounds are 
not displayed in preview mode (see Preview Settings on p. 32). 

• Background Image Opacity – For custom background images, sets the opacity 
(the opposite of transparency) of the image. Setting a lower opacity reduces 
contrast in the image, allowing menu objects to stand out more. 

• To remove a background image, check the Don’t display custom background 
box. 

3. Background Audio – Opens the Menu Audio Properties window.  
• Click on the Memories Builder Library icon (the blue folder) to choose one of 

the music files that comes with Memories Builder to play in the background of 
the menu.  

• Click on the yellow open folder icon to browse for one of your own music files 
to play in the background of the menu (WAV, MP3, AIFF, AU, MIDI). 

• If you decide not to use background music, check the Don’t play audio selection 
box. 

• The Play and Clear buttons allow you to hear or remove the audio file from the 
menu (respectively). 

4. Motion Buttons – Enables motion menu buttons. When motion buttons are enabled, 
each menu button will show a short preview of its contents (if the button leads to a 
video or slideshow) until the user makes a selection. See the motion button info on p. 
16. 

5. Motion Menu Loop Length – If motion buttons are enabled or if your project 
includes menus with background video, this button sets the maximum motion loop 
length for every menu in the project. Drag the slider to choose the maximum loop 
length. 
Note: If a motion menu background video is shorter than the maximum loop length, 
that menu (both buttons and background) will only loop for the duration of the 
background movie. 

6. Menu Button/Title Fonts – Allows you to change the font for menu titles and buttons. 
Changes will be applied to the current menu and any of its submenus that do not 
already have a custom menu style. 

7. Help – Launches the Help files, organized by subject. The Help files also feature a 
search function. 

8. Send YBI Feedback – Click on this icon to launch a Web browser that will go to 
Yearbook Interactive’s feedback page. 
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Slide Tools 
Slide Tools allow you to quickly build slideshows and edit slides. They include functions 
for placing images, text, and shapes, as well as modifying the general slideshow settings. 
To access these tools, select a slideshow in the Contents window. The Slide Tools appear 
next to the General Tools on the top toolbar. 
 

 

Icon Descriptions: 
1. Add Slide – Creates a new slide and places it at the end of the slideshow. 
2. Add Slide with Template – Creates a new slide, allowing you to choose the template 

to use. 
3. Auto Slide Builder – Launches the Auto Slide Builder. See p. 23. 
4. Add Image – Opens a browse window for selecting an image to add to the current 

slideshow slide. 
5. Add Text – Allows you to add captions and titles to the current slide and edit the 

appearance of the text. 
6. Add Shape – Displays a selection list of shapes to create on a slideshow slide. See p. 

25 for more information. 
7. Slideshow Properties – Opens the Slideshow Properties dialog box. See p. 25. 
8. Help – Launches the Help files. 
9. Send YBI Feedback – Click on this icon to launch a Web browser that will go to 

Yearbook Interactive’s feedback page. 
 
There are also three icons to the left of the timeline (just below the slide workspace): 

 - Add a new slide at the end of the slideshow presentation. 

 - Hide the currently selected slide. The slide will not display in the slideshow. 

 - Permanently remove the currently selected slide from the slideshow. 
 

Video Tools 
Only the Help and Feedback icons are available. 
 
 

Objects Tools (Button, Image, Shape, and Text Tools) 
The functions available through the Objects Toolbar change according to what the 
workspace is displaying. The four available tool sets are Button Tools, Image Tools, 
Shape Tools, and Text Tools. 
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Button Tools 
The Button Tools are for customizing the appearance of buttons in a menu. To access this 
tool set, click on the button you wish to customize on the workspace. The following tool 
icons appear just above the workspace: 
 

 

Icon Descriptions: 
1. Button Start Point (Video and Slideshow Buttons) – Changes the preview frame for a 

movie or slideshow (see p. 17). It also selects the start point for the motion button 
loop (if motion buttons are enabled). Click the icon to open a pop-up slider. Drag the 
slider to adjust the setting. 

2. Menu Button/Title Fonts – Allows you to change the font for menu titles and buttons. 
Changes will be applied to the current menu and any of its submenus that do not 
already have a custom menu style. 

 

Image Tools 
When you select a slideshow image, Memories Builder DVD will display the Image 
Tools just above the workspace. The Image Tools allow you to edit images in a number 
of ways. 
 

 

Icon Descriptions: 
1. Zoom In – Click on this icon to increase the size of the image. 
2. Zoom Out – Click on this icon to decrease the size of the image. 
3. Rotate Counterclockwise – Turns the image 90° counterclockwise. 
4. Rotate Clockwise – Turns the image 90° clockwise. 
5. Free Rotate Image – Drag the slider or type in a number of degrees to rotate the 

image. Positive values rotate the image clockwise, while negative values rotate the 
image counter-clockwise. If typing in the degree, use a minus (-) symbol to indicate 
negative values. 

6. Crop – Allows you to select an area of a slideshow image to keep, deleting the 
unwanted portions (see p. 22). 

7. Image Effects Drop-down – Applies effects to the selected image. The available 
effects are:  
• Sharpen – Increases the focus or definition of the image. 
• Blur – Softens the focus or reduces the definition of the image. 



Memories Builder DVD 2.1 – Program Menus and Toolbars 

42 

• Negative – Reverses the light patterns of the current image. 
• Darken – Moves the balance of light and dark shades in the image more toward 

the dark shades. 
• Brighten – Moves the balance of light and dark shades in the image more toward 

the light shades. 
• Gamma Correction – Adjusting the gamma of an image allows you to change 

brightness values of the middle range of gray tones without dramatically altering 
the shadows and highlights. 

• Emboss – Makes the image look like it has been pressed onto the project 
workspace. 

• Sketch – Simulates a drawing of the image (black and white). 
• Black/White – Transforms a color image into a black and white image. 
• Fish Eye – Simulates viewing the image through a fisheye lens, a lens that 

distorts the image to make the middle portion of the image appear larger and the 
outer edges appear smaller. 

• Impressionist Painting – Gives the image an artistic brushed look. 
• Mirror – Flips the image around horizontally, like seeing the mirror image. 
• Flip – Turns the image upside-down, like seeing a reflection of the image. 

8. Opacity – Adjusts the opacity of the selected image. Opacity is the opposite of 
transparency. 

9. Shadow - Displays a shadow underneath an image to make it stand out and to give it 
a sense of depth on the slide. Click on the Shadow icon to bring up the Shadow 
Properties Dialog. 

 
• Click on the Shadow Color square to adjust the hue of the shadow. 
• To move the shadow, click and hold the mouse down in the white box area as 

you move the mouse. You may also use the arrow keys on your keyboard to 
move the shadow. 
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• Drag the Opacity slider to adjust the transparency of the shadow. Higher values 
for the slider make the shadow more opaque (darker); lower values make it more 
transparent. 

• Drag the Blur slider to adjust the depth of the shadow around the edges. Lower 
values for the slider make the shadow darker around the edges, while higher 
values lighten the shadow edge. 

• The Enable Shadow checkbox allows you to quickly apply or remove the 
shadow. 

• Click the OK button to apply your changes to the shadow and return to the slide. 
 

Shape Tools 
The Shape Tools allow you to modify shapes in a number of ways, including rotation, 
transparency, fills, and borders. Selecting a shape on a slide brings up the following tool 
icons just above the workspace: 
 

 

Icon Descriptions: 
1. Type – Changes the basic shape (e.g. changing from a triangle to a circle). 
2. Points/Sides – If the number of points or sides is not pre-determined by the type of 

shape (e.g. polygons or stars), this drop-down will change the number of points or 
sides the shape has. 

3. Border Color – Changes the color of the shape’s border. 
4. Border Thickness – Changes the thickness of the shape’s border. 
5. Border Corner Style – Changes the appearance of the border’s corners. 
6. Rotate – Turns the shape the amount and direction you set with the slider. 
7. Fill – Changes the color of the shape, not including the shape’s border. To fill the 

shape with an image, choose Image from the drop-down and browse for an image. To 
edit the way the image looks in the shape, double-click on the shape. The Shape 
Image Editor appears: 
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• Click on the image and hold the mouse button down as you drag the mouse to 
move the image inside the shape. 

• Click on the Zoom In or Zoom Out buttons to make the image larger or smaller 
inside the shape. 

• Checking the Rotate image with shape box will lock the image to the shape so 
that the image will rotate with the shape whenever it is rotated (otherwise the 
image will retain its original orientation when the shape is rotated). 

• Click on the Replace Image button to browse for a different image file. 
• Click on the Reset button to return the image to its original size and position in 

the shape. 
• Click OK when you are finished. 

8. Fill Opacity – Adjusts the opacity of the selected shape fill. Opacity is the opposite of 
transparency. 

9. Shadow - Displays a shadow underneath a shape to make it stand out and to give it a 
sense of depth on the slide. Click on the Shadow icon to bring up the Shadow 
Properties Dialog. 

 
• Click on the Shadow Color square to adjust the hue of the shadow. 
• To move the shadow, click and hold the mouse down in the white box area as 

you move the mouse. You may also use the arrow keys on your keyboard to 
move the shadow. 

• Drag the Opacity slider to adjust the transparency of the shadow. Higher values 
for the slider make the shadow more opaque (darker); lower values make it more 
transparent. 

• The Enable Shadow checkbox allows you to quickly apply or remove the 
shadow. 

• Click the OK button to apply your changes to the shadow and return to the slide. 
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Text Tools 
The Text Tools give you control over the appearance of text on slideshow slides. Select 
the text to bring up the following icons just above the workspace:  
 

 

Icon Descriptions: 
1. Font – Changes the style of the text. 
2. Size – Changes the size of the text. 
3. Bold – Increases the thickness of the text. 
4. Italic – Applies an italic style to the text. 
5. Underline – Applies an underline to the text. 
6. Left Align – Justifies the text to the left of the text box. 
7. Center Align – Centers the text in the text box. 
8. Right Align – Justifies the text to the right of the text box. 
9. Color – Changes the color of the text. 
10. Shadow- Displays a shadow underneath the text to make it stand out and to give it a 

sense of depth on the slide. Click on the Shadow icon to bring up the Shadow 
Properties Dialog. 

 
• Click on the Shadow Color square to adjust the hue of the shadow. 
• To move the shadow, click and hold the mouse down in the white box area as 

you move the mouse. You may also use the arrow keys on your keyboard to 
move the shadow. 

• Drag the Opacity slider to adjust the transparency of the shadow. Higher values 
for the slider make the shadow more opaque (darker); lower values make it more 
transparent. 
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• The Enable Shadow checkbox allows you to quickly apply or remove the 
shadow. 

• Click the OK button to apply your changes to the shadow and return to the slide. 
 
 

Program Menus 
 

File 
New Project – Begins the process for creating a Memories Builder DVD project (and 

closes the current project). 
Open Project – Provides access to Memories Builder DVD projects through a browse 

window. 
Close Project – Closes the current project without exiting Memories Builder DVD. 
Save – Saves (writes the project to disk) in the current or default location with the current 

filename. The default location is in the Memories Builder DVD Version 2.1 folder 
inside a folder named DVDProj. 

Save As – Saves project in custom location with new name (the previously named project 
will exist separately under the original name). Warning: DVD projects require large 
amounts of free hard drive space. 

Print Slide (Slideshows only) – Sends the current slide to the default printer. Printed 
slides are useful for closer proofing. 

Backup Project – Creates a safety copy of the open project and all of its files. 
Recent Projects – Displays a list of the projects you have opened recently. Click on a 

project to open it. 
Exit – Closes the Memories Builder DVD program. 
 

Edit 
Undo – Cancels the last operation (applies to slideshow editing). 
Redo – Reverses the undo operation. 
Cut – Removes a slideshow object to the clipboard to be pasted in another location. 
Copy – Copies a slideshow object to the clipboard to be pasted in another location. 
Paste – Applies the slideshow object stored on the clipboard to the current slide. 
Delete Object – Removes the currently selected object from a slide. 
Delete Contents Item – Brings up a dialog for selecting and deleting project contents. 

Useful for deleting menus, slides, or videos that are generating errors. 
Check Project for Errors – Brings up a utility that checks for errors in the project and 

displays a printable list of results. 
Select All – Selects all of the objects on a slide. 
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Preferences – Opens the Preferences dialog, which includes settings for Project Quality 
Mode, Grids, and Preview motion. See Project Preferences on p. 31. 

 

Modify 
Rename – Changes the name of the item currently selected in the Contents window. 
Project Plan – Brings up the Project Planning dialog, where you can view and change 

plan attributes. 
Compare to Plan – Brings up a dialog that shows how much of the project you’ve built 

alongside a review of the projections you created in the project plan, as well as 
deadlines and assignments. 

Bring to Front – Moves the selected slideshow object in front of all other slide objects. 
Send to Back – Moves the selected slideshow object behind all other slide objects. 
Bring Forward – Moves the selected slideshow object one layer forward. 
Send Backward – Moves the selected slideshow object back one layer. 
Align (Slideshow objects) 

Top – Aligns all selected objects to the topmost object on the slide. 
Middle – Aligns the middles of all selected objects. 
Bottom – Aligns all selected objects to the bottommost object on the slide. 
Left – Aligns all selected objects to the leftmost object on the slide. 
Center – Aligns the centers of all selected objects. 
Right – Aligns all selected objects to the rightmost object on the slide. 
Center Vertical on Slide – Places all selected objects in the vertical center of the 

slide. 
Center Horizontal on Slide – Places all selected objects in the horizontal center of the 

slide. 
Snap to Slideshow Grid – Displays a grid in the workspace for assistance in placement of 

slide objects. Slideshow objects will “snap” to the grid point nearest the top left 
corner of the slide object when moved. 

Show Slideshow Grid – Displays a grid in the workspace for assistance in placement of 
slideshow objects (slide objects don’t snap). 

Show Safe Area – Displays an overlay that indicates which part of the workspace is most 
useful for critical images, text, and navigation (not all of the workspace will appear 
on a typical TV screen). 

 

Insert 
New Menu – Creates a menu as a submenu of the currently selected menu. 
New Movie – Opens a browse window for selecting a video to add to the current menu. 
New Slideshow – Creates a slideshow in the currently selected menu. See p. 19. 
New Slide – Creates a new slide and places it at the end of the currently selected 

slideshow.



Memories Builder DVD 2.1 – Program Menus and Toolbars 

48 

New Slide Template – Creates a new slide at the end of the currently selected slideshow, 
allowing you to choose the template to use. 

Import – Brings contents from another project into the current project. See p. 56. 
Auto Slide Builder – Launches the Auto Slide Builder. See p. 23. 
Add Image – Opens a browse window for selecting an image to add to the current 

slideshow slide. 
Add Text – Allows you to define a text box on the current slide for typing in and editing 

the appearance of text. 
Add Shape – Displays a selection list of shapes to create on a slideshow slide. See p. 25 

for more information. 
 

Finalize Project 
Step 1: Preview Project – Shows the current project in a mode that simulates the final 

DVD product. 
Step 2: Check Project for Errors – Brings up a utility that checks for errors in the project 

and displays a printable list of results. 
Step 3: Check Spelling – Brings up a utility that checks the spelling in slideshow text 

boxes, points out errors, and suggests changes. 
Step 4: Export for Submission – Copies your project to a portable hard drive in 

preparation for sending the project to Yearbook Interactive. 
Finalize Project Help – Brings up detailed information about the steps for finalizing a 

project. 
 

Help 
Memories Builder Help – Brings up the help system, which contains topics, an index, and 

a search function for finding help with program functions. 
Check for Updates – If your computer is connected to the Internet, this will check to see 

if you have the most current version of Memories Builder DVD. 
User’s Guide – Opens this User's Guide, a print-ready document that contains complete 

information about using Memories Builder DVD. 
Yearbook Interactive Web Site – Launches the Yearbook Interactive Web site, which 

contains information and updates for Memories Builder DVD. 
Tutorial – Opens a document that leads you through the basic steps of using Memories 

Builder DVD. 
About Memories Builder – Displays a screen that contains copyright and version 

information for Memories Builder DVD. 
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Project Building - Approaches and Tips 
 
Reading the following information will make a critical difference in the success of your 
project: 
• What you will be building (a YBI DVD) 
• How to organize your content (the images and video you will be using in your 

project) 
• What Memories Builder DVD does 
• Preparing video 
• Sample menu structures 
• Memories Builder supported formats 
 
 

The YBI DVD – Quick Summary 
Suggestions for understanding the YBI DVD: 
• View the DVD sample. 
• If you didn’t get a sample, ask your Customer Service Representative for one (877 

463-6924). 
• Read DVD Concepts on p. 6 for information about DVD-Video. 
• Preview the project frequently to see how users will view and interact with the final 

product. See page 28 for more information. 
 
A YBI DVD brings your school memories to life by adding a new dimension to the print 
yearbook. Summary of a YBI DVD: 
• Presentation on DVD that brings your memories to life with video and audio. 
• DVD-Video format – the same format that DVD movies from the video store use. 
• Works on DVD console (set-top) players or DVD-ROM computer drives. 
 
How the presentation works: 
• Launches the title menu on startup (top item in the Contents window). 
• Users choose from the menu options you provide them by selecting menu buttons. 
• Menu buttons can launch a video, a slideshow (a series of still images), or a 

submenu. 
 
What you will be doing: 
• Preparing video segments to import into the presentation. 
• Organizing the structure of menus. 
• Preparing slideshows. 
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How to Organize Your Content 
Organizing your content before building your project will help you avoid confusion and 
keep track of how much you have done. Here are some suggestions: 
• Have a computer systems administrator install Memories Builder DVD to the default 

location. If you experience trouble accessing you project, you may need to have a 
computer systems administrator give you access to the proper folders. Contact Tech 
Support for more information (877-463-6924 ext. 23). 

• We recommend that you save projects to your computer’s local hard drive (rather 
than a network drive), if possible. We also recommend using the same computer 
every day. These two items will help you keep track of how much hard drive space 
you have available, and give you better control over the project. 

• Organize your files according to type or the menu that they will go in. For example, 
you could put all of your video files in a single folder, or you could create a series of 
folders with the same names as your menus and place all files you will use in the 
menu in the folder (video files, images for slideshows, music). 

• Give video segments unique, meaningful names. It will be much easier to locate the 
right video file if it includes the name of its menu and something to identify its 
unique content (e.g. Sports-SoccerFinals.mov).  

 

What Memories Builder DVD does 
Memories Builder DVD helps you organize your content into a series of menus and titles 
(videos and slideshows). Memories Builder DVD also gives you the tools to create your 
slideshows and create a look for the DVD. Finally, it gives you the tools you need to 
prepare your project to send to Yearbook Interactive for encoding onto a DVD for 
duplication. 
 

Preparing Video 
Good video files and footage are critical to a good DVD multimedia supplement. 
Unfortunately, video capturing and editing can be a pretty confusing and challenging 
subject. This overview is just intended to get you started.  

For a more detailed introduction to video editing, go to the following Web address: 
http://electronics.howstuffworks.com/video-editing.htm 
 
There are four basic phases of video editing: 

Phase I: Footage – Getting and using a video camera. 
If you do not already have a video camera, consult with your local electronics stores for 
more information on purchasing and using video cameras. We recommend that you use a 
digital camcorder that uses MiniDV tapes. 
Since the operational methods of video equipment vary widely, you will need to consult 
your video camera’s documentation for information on using your video camera. It’s a 

http://electronics.howstuffworks.com/video-editing.htm
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good practice to shoot a few more seconds of footage before and after the event you are 
trying to capture because it will make editing easier. 
 

Phase II: Capturing – Transferring the footage from the video camera 
to computer. 
Video can be imported to your computer in one of two ways: 
 

Analog Video Capture    or  Digital Video (DV) Capture 
 

 
 
 
 

 (RCA) Analog Cables    Analog Capture Card (PCI)     DV Cable            DV Card (PCI)  
 
Depending on whether you are using a digital or analog camcorder or camera, you may 
need to purchase an analog video capture card ($129 to $399) or a DV capture card ($29 
to $199) if your computer doesn’t have one. Many new Apple™ PowerMacs, iMacs, 
PowerBooks, and iBooks include built in DV capture called FireWire™.  Some new PC 
computers include DV capture called iLink™, FireWire, or IEEE1394.  If you have a 
computer with DV ports but only have video on VHS cassettes (analog video) you will 
need a media converter ($249-$399) or an analog capture card.  Some DV camcorders 
can convert analog video to digital video (basically a media converter built in). 
 

Phase III: Editing – Trimming footage and adding effects and titles. 
Some popular programs with varying features and costs are listed below: 
• iMovie™ (included with OS X, Mac only) 
• Final Cut Pro™ ($299 for schools, Mac only) 
• Adobe Premiere ($699 PC & Mac) 
 
Check your program’s documentation for more information on the editing process. 
 

Phase IV: Export – Saving the edited file to a computer file. 
This process also depends on your video editing program. Check your documentation for 
the specific instructions. We recommend that you choose a DV format or an 
uncompressed AVI or QuickTime movie format. Export your movies at full size (usually 
720x480). Other supported formats include QuickTime Movie Format (.MOV), AVI - 
Cinepak codec only, MPEG Format (.MPG) - Warning: These are usually low quality 
videos. We don't recommend this format unless you have no other choice. 

See the Video section starting on page 17 for more information on video. 
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Sample Menu Structure: 
 

 
 
Key 

 = Menu  = Movie  = Slideshow 
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Memories Builder Supported Formats 
The formats that Memories Builder DVD supports are determined by QuickTime. If you 
can open a file in QuickTime, it is compatible with Memories Builder. 
 

Audio 
WAV (Windows default) 
AIFF (Mac default) 
MP3 
MIDI 
 

Images 
JPG 
PNG (Use this format to preserve transparency.) 
GIF 
BMP 
TIF (CMYK mode images may not display well. We recommend RGB mode.) 
PSD 
PIC 
 

Video 
DV 
AVI (DV-AVI or Cinepak codec only) 
QuickTime Movie (.MOV) 
MPEG I (.MPG) – Not recommended, based on its typically low quality. 
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Appendix A: Project Limitations and Constraints 
 

Size Limitations 
• The DVD specification only allows for 99 titles (i.e. movies or slideshows) per DVD.  
• Only 60 minutes of high quality video can fit on a DVD. A 2-hour mode is also 

available, which uses average quality video. (DVDs created by Memories Builder are 
single-sided, single-layer discs.) 

• The workspace of Memories Builder DVD is 640 pixels wide and 480 pixels high 
(640x480) because this is the size of the viewing area on a standard television set. 
However, videos exported for use in Memories Builder should be sized at 720x480. 

• Note: Many users ask, “If a DVD holds 7 times more data than a CD, why can we 
only have 60 (or 120) minutes of video? Hollywood videos have at least 2 hours of 
video, if not more.” The answer is complex, but stated simply: 1) DVD-Video is a 
specific format (like CD-Audio) and must be created using defined standards.  2) 
DVD-Video requires a lot of (data) space to provide a high quality video image. 3) 
“Hollywood” DVDs are often produced with multiple data layers on a single disc. 
Current consumer-oriented DVD authoring is only geared for replication of single 
layer discs. 

Motion Menus 
• Motion Menus can have a maximum loop length of 60 seconds or shorter. 
• Because most computers are not able to play raw (uncompressed) projects before 

Yearbook Interactive has compressed the project in DVD format, Memories Builder 
does not display button motion or background motion in the Preview mode by 
default. You may enable motion in Preview by choosing from the options on the 
Preview Settings tab in the Preferences dialog (choose Preferences from the Edit 
menu). Try different settings to reduce jitter or freezing. In any case, your final DVD 
will have motion, if enabled. 

• The Maximum Menu Loop Length setting affects menu background video and audio 
differently. Video backgrounds can be shorter than the Maximum Menu Loop Length 
and will just loop more often. However if a menu background audio file is shorter 
than the Maximum Loop Length, a period of silence may result. Ensure that your 
audio files are longer than the maximum loop length to avoid silence. 

Slideshows 
• The DVD-Video specification only allows for 99 slides per slideshow.  
• Slides cannot be displayed for fewer than 2 second intervals (unless set to “Manual 

Advance.”) 
• Manual-advance slideshows cannot have background audio or transitions.  
• To avoid silence at the end of a slideshow, background audio selections for 

slideshows should be long enough to fill the duration of the slideshow, the slide 
intervals should be reduced to shorten the duration, or the loop option should be 
checked.
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Movies 
• Memories Builder supports only .dv, .mov, .avi, and .mpg movie file types. 
• Video should always be brought in at the highest quality possible with an optimum 

frame size of 720x480 pixels. Avoid compressing the video, if possible. 
• Uncompressed video may be taxing on your computer’s resources. Even in Memories 

Builder DVD, the video may not stream smoothly. However, when submitted to 
Yearbook Interactive, the video will be transcoded and optimized for DVD and will 
play smoothly on DVD players. 

Audio 
• If Motion Buttons are not enabled and no motion background video has been chosen, 

menu background audio will play through the end of the clip, but will not loop. 
• If Motion Buttons are enabled, the audio clip will play for the duration of the menu 

loop length and then start over again (e.g. If the maximum menu length is set to 0:40 
seconds, a 0:60 audio clip will play for 0:40 seconds and then start again at the 
beginning.). If the audio clip is shorter than the Maximum Loop Length, a period of 
silence may result every time the menu loops. 

• The Memories Builder Preview does not completely mirror the final DVD audio 
looping. In the final product, if the audio file you have chosen is shorter than the 
maximum menu loop length (see p. 15), there will be silence in the space between the 
end of the audio file and the point at which the menu loop begins again. Preview 
mode does not accurately reflect this. 

• Memories Builder supports .wav, .mp3, and .aiff audio file types. 

Images 
• Memories Builder supports .jpg, .png, .bmp, .gif, .pic, and .tif image file formats. 

Fonts 
• Memories Builder allows for the use of a few basic fonts and all YearTech (AYT) 

fonts. If YearTech fonts are not already on your computer, you can install them from 
the YearTech disc. 
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Appendix B: Building on Multiple Computers 
 
Introductory Note: 
Memories Builder DVD projects are not designed to be opened, accessed, or modified by 
more than one computer at a time. Doing so will delete parts of the project. Rather than 
creating a single project and having a number of users access it, have each student create 
an individual project and then import all of the parts using the Import function. 
 

Setup 
1. Install Memories Builder on every computer you will use to create your project. We 

suggest using the default installation options. 
2. Assign portions of the project to each student. The typical approach is to divide the 

work among the students by menu. For example, one student could work on the 
Student Life menu, while another student works on Sports. Have each student create 
his or her own project file, preferably saving it to the local hard drive (unless school 
security requires that you save it to a network drive). We suggest that you use the 
student’s name or menu name in the project filename (e.g. heather.sb3 or sports.sb3).  

3. When you are creating project files, designate one project as the master project. 
4. After all of the students have completed their parts of the project, import them into 

the master project using the steps below. 
 

To combine projects into one master project: 
Before submitting your project, all contents that will be in the final presentation must be 
in the master project. To combine work from multiple computers: 
1. Designate one machine as the master machine. Use a computer that has network 

access to the other machines with projects (or burn each individual machine’s project 
file and folder onto a CD and import from the CD). 

2. Open the master project.  
3. In the Contents window, choose a 

location for the slide(s), menu(s), or 
menu item(s) to import by selecting 
an item in the Contents window.   

4. Choose Import from the Insert menu. 
The Import dialog opens (see image 
at right). 

5. Click on the open folder icon next to 
the Select the Project to import from: 
field and browse for the project folder 
which contains the contents to 
import.
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6. The Select window will show the contents of the project. Click on the plus symbols 
(arrow on the Mac) to open menus. Select the first item to import in the Contents 
window. Click on the Show Preview box to see a preview of the item. Click Import 
when you are satisfied with your selection. The icon of the imported item will turn 
gray. Repeat as needed.  

7. Click the Close button when you have finished importing. 
8. The imported contents will now appear in the master project. Importing slideshows 

will also bring their background images and background music with them. 
9. Save the project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Memories Builder DVD 2.1 – Appendix C 

58 

Appendix C: Documents 
 
This appendix contains program-related documents. 
 
License Agreement – This copy of the License Agreement that you accepted when you 
installed the program is reprinted here for your convenience. 
Security and Memories Builder – Information about setting up Memories Builder DVD 
on Windows 2000 or Windows XP Professional computers.  
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Memories Builder DVD™ License Agreement 
 
Note: This User’s Guide contains this License Agreement as a courtesy. It is a copy of the 
agreement that you approved when you installed Memories Builder DVD.  
 
Thank you for your interest in Memories Builder DVD.  In order to proceed with the 
installation of this software program, you must review and agree to the terms of this 
License Agreement.   This Agreement describes the licensed uses of the Memories 
Builder DVD software, and its installation.  By indicating your agreement to this license, 
you have not obligated yourself or your school to purchase any number of YBI DVDs for 
your school yearbook.   
 
Important  -- clicking Next indicates agreement to this license. 
You should carefully read the following terms and conditions before opening, 
installing, or using the Memories Builder DVD software package.  The 
downloading, opening, installation or use of the Memories Builder DVD software 
package shall in all cases be construed to mean that you accept these terms and 
conditions and understand that they will be legally binding on you and your school, 
as well as any end user. If you do not agree with these terms and conditions, or do 
not want them to be binding on you, you should delete the Memories Builder DVD 
software package from any storage medium that it is stored on.  
 

Ownership  
You acknowledge and agree that StoryRock, Inc., doing business as Yearbook Interactive 
("Licensor") is the owner of all right, title and interest in and to the software, whether 
downloaded or otherwise obtained, and the computer programs contained therein in 
machine readable object code form as well as the accompanying user documentation 
along with all subsequent copies thereof, regardless of the media or form in which they 
may exist (collectively the "Software"). The Software, and any photographs or images 
included in the Software, is protected by United States copyright laws and international 
treaty provisions, and this License Agreement does not convey to you any interest in or to 
the Software, digital content, or any accompanying printed materials, but only a limited 
right of use and limited right of reproduction which is revocable in accordance with the 
terms of this License Agreement.  
 

License  
1. Grant of License. Licensor hereby grants and you accept a nonexclusive license to 

use the Software in accordance with the terms of this Agreement.  
2. All photographs and imagery contained within the Memories Builder DVD software 

are copyrighted by the credited photographer or photo source. The Memories Builder 
DVD images cannot be used outside of the Memories Builder DVD software.  
Exporting the Memories Builder DVD images into ANY OTHER SOFTWARE 
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product is expressly prohibited. No other distribution of the Memories Builder DVD 
images is authorized. 

3. Reservation of Rights. All rights not expressly granted to you by this License 
Agreement are hereby reserved by Licensor.  

4. No Disassembly. It is understood and agreed that you shall not copy the program into 
any machine-readable or printed form except for archival or for backup purposes in 
accordance with the terms of this Agreement, nor shall you reverse engineer, 
decompile, disassemble, translate, merge into another computer program, obscure or 
remove Licensor's copyright notice or otherwise modify the Software.  

5. No Rental. You may not rent or lease the Software or any right or license granted 
under this Agreement.  

6. Transfer of Software. You shall not sublicense, assign, or transfer the license or the 
Software or any rights under this Agreement without the prior written consent of 
Licensor. Any attempt otherwise to sublicense, assign, or transfer any of the rights, 
duties, or obligations hereunder is void.  

7. Updates and New Versions. In the event that updates or new versions of the Software 
are developed, Licensor may, at its discretion, make such updates and new versions 
available to you upon payment of any required fees, if any, and return of the original 
Software to Licensor, if demanded. If the Software is updated and made available to 
you, you may use the updated or new versions of the Software in accordance with the 
terms and conditions of this License Agreement.  

8. Term and Termination. This License Agreement is effective upon your opening the 
Software package, or its initial use if downloaded, and shall continue for a period of 
five (5) years unless terminated earlier in accordance with the terms herein. You may 
terminate this License Agreement at any time by returning the Software and all 
copies thereof and extracts there from to Licensor.  

9. Dual Media. You may receive the Software in more than one storage medium. You 
may use the medium that is appropriate for your computer(s). You may not use, 
copy, transmit, lease, rent, sell, assign or otherwise transfer any medium containing 
the Software to another user.  For the purposes of this Agreement, a licensed and 
accredited school shall be considered a single user, and such school shall be entitled 
to install one copy of the Software on as many computers within the school as are 
necessary or desirable to complete a YBI DVD or multiple supplements for that 
single user school.  

10. Limited Warranty. Licensor warrants the disks or medium on which the Software 
program is furnished to be free from defects in materials and workmanship under 
normal use for a period of ninety (90) days from the date of delivery to Licensee, as 
evidenced by your receipt. You shall assume responsibility for the selection of the 
Software and for the installation, use, and results obtained from the Software. The 
entire risk as to the quality and performance of the Software is with you.  
The program is provided "as is" without warranty of any kind, either express or 
implied, including, but not limited to, the implied warranties of merchantability 
and fitness for a particular purpose. Licensor does not warrant that the 
functions contained in the software will meet your requirements or that the 
operation of the software will be uninterrupted or error free. 
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Some states do not allow the exclusion of implied warranties, so the above exclusion 
may not apply to you. This warranty gives you specific legal rights, and you may also 
have other rights that vary from state to state.  

11. Final Submissions.  The only use of the Software licensed under this Agreement 
requires the user to use the Software's routines to assemble and compile a multimedia 
yearbook supplement project(s) for a single school user.  Such projects are only to be 
used for submission back to the Licensor for replication or duplication.  A separate 
charge per disc is made for the replication or duplication of any project completed 
using the Software. You, the school user, assume the entire responsibility for the 
content submitted to StoryRock, Inc., and specifically warrant that: 
a. You have reviewed the entire content of the multimedia yearbook supplement 

project submitted to StoryRock, including all images, text, movies, files, and 
links prior to submission, and that  

b. You have approved all such content as un-offensive, accurate, and appropriate 
for distribution to the audience for which it is intended, and that  

c. You have obtained appropriate permission to use copyrighted materials, if 
included, wherever necessary or appropriate.  

d. You acknowledge that all materials submitted to StoryRock become the property 
of StoryRock for the purpose of replication or reproduction.  StoryRock may at 
its sole discretion make additional copies of complete projects, or any file, 
picture, video, sound, link, or the like contained thereon for distribution as 
sample projects. 

Neither StoryRock nor any of their affiliates, representatives, etc. assume any 
liability of any kind for the content compiled using the software, whether 
submitted to it for replication or duplication, or not.  

12. Remedies. Licensor's entire liability and your exclusive remedy shall be: The 
replacement of any Software disk or medium not meeting Licensor's "Limited 
Warranty" above and that is returned to Licensor with a copy of your receipt; or if 
Licensor is unable to deliver a replacement copy that is free of defects in materials or 
workmanship, you may terminate this Agreement by returning the Software product 
for a full refund of the purchase price, if any.  

13. Limitations of Liability. IN NO EVENT WILL LICENSOR BE LIABLE FOR ANY 
DAMAGES, INCLUDING BUT NOT LIMITED TO, LOST PROFITS, LOST 
SAVINGS, LOST TIME, LOST FILES OR OTHER SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY 
TO USE THE SOFTWARE EVEN IF LICENSOR OR ITS EMPLOYEES OR 
REPRESENTATIVES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.  
In any event, Licensor's cumulative liability to you or any other third party for any 
loss or damages resulting from any claims, demands, or actions arising out of or 
relating to this Agreement shall not exceed the license fee paid by you to Licensor for 
the license and use of this Software.  

14. Jurisdiction and Disputes. This Agreement and the Limited Warranty provide for 
herein shall be governed by the laws of Utah. All disputes hereunder shall be 
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resolved in the applicable state or federal courts of Utah, and the parties consent to 
the jurisdiction and venue therein. The application of the United Nations Convention 
on Contracts for the International Sale of Goods is hereby expressly waived and 
excluded.  

15. U.S. Government Restricted Rights. The Software and documentation are provided 
with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in 
Technical Data and Computer software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted 
Rights and 48 CFR 52.227-19, as applicable. Manufacturer is StoryRock, Inc. 474 
Bearcat Drive, Salt Lake City, UT 84115. 

16. Integration. This Agreement constitutes the entire understanding of the parties 
relating to the license of the Software, and revokes and supersedes all prior 
agreements, oral or written, between the Licensor and you, and is intended as a final 
expression of the Agreement. It shall not be modified or amended except in a writing 
signed by an officer of StoryRock, Inc. specifically referring to this Agreement. This 
Agreement shall take precedence over any other documents that may be in conflict 
therewith.  

 

Questions  
All questions concerning this Agreement may be directed to manufacturer: 
StoryRock, Inc.  
474 Bearcat Drive 
SLC, UT 84115 
or to: 
Service@StoryRock.com 
 
You hereby acknowledge that you have read these software program license terms 
and conditions, understand them and agree to be bound by them.  
 

Memories Builder DVD™  ©2004  All rights reserved. 
 
 
 
 
 

mailto:service@storyrock.com
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Folder Access, Security, and Memories Builder 
 
Introduction 
This document is for computer system administrators and applies specifically to 
computers running Windows 2000 and Windows XP Professional. 
 
In order for Memories Builder to function properly, each user will need access to certain 
folders. The Memories Builder program reads, writes, modifies, and deletes files and 
folders. It also creates some subfolders. 
 
Many computer system administrators are concerned about giving students access control 
to any part of the system or network. Memories Builder only requires access to non-
critical files and folders on the computer. Specifically, users will need access to the 
Memories Builder DVD Version 2.1 program folder and a folder somewhere else on the 
computer or network in which they may save their projects. 
 
Basic Program Information 
Here is some information that will help you decide how to accommodate Memories 
Builder: 
• By default Memories Builder installs to C:\Program Files\ Memories Builder DVD 

Version 2.1 (custom installation is available). 
• By default Memories Builder creates and saves projects to C:\Program Files\ 

Memories Builder DVD Version 2.1\DVDProj. Users can choose to save projects 
anywhere on the local machine and on any mapped network drive. 

• Some computer administrators have installed Memories Builder to the All Users 
folder in Documents and Settings or saved projects to that same location to allow all 
users to use the program and access the files. Even if you decide to do that, you will 
still need to set access control for those folders. 

 
Recommendations 
The fastest and simplest way to get Memories Builder to work for all computers is to use 
Memories Builder’s default options. To set up a computer to use Memories Builder: 
1. Log in to the computer as an administrator. 
2. Insert the Memories Builder disc into the computer’s CD-ROM drive. 
3. The CD should automatically launch a menu. If not, locate the CD from My 

Computer. Click with the right mouse button on the CD drive, and select Explore 
from the menu that pops up. In the new browse window, double-click on 
MBDVDMenu.exe. 

4. Choose Install Memories Builder from the CD menu. Follow the steps to install 
Memories Builder, using the default locations and settings. 

5. After installation, browse to the Program Files folder.
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6. Right-click on the Memories Builder DVD Version 2.1 folder and choose 
Properties. 

7. Click on the Security tab. If the tab is not visible, follow the instructions in the 
Enable Security section below. 

8. In the top box, choose the user or user group for the student(s) who will be using 
Memories Builder. You may need to add the user or user group with using the Add 
button. 

9. Choose Full Control for this folder (the Allow checkbox). This will only affect the 
Memories Builder DVD Version 2.1 folder. Click OK or Apply.  

10. If students will be saving their projects to a location other than the default location, 
you will also need to set access control for that folder. If this is how you would like 
the students to operate, we suggest that you create a folder for Memories Builder 
projects and give students full access to the folder. 

 
Other Options 
Some computer system administrators have experimented with setting the students’ 
permissions to Modify (rather than Full Control). This may cause a problem with a file 
that Memories Builder uses to ensure that students don’t try to access project files at the 
same time. You can check for this problem by creating a new project in a student’s 
account, closing the project, and reopening it. If the project opens without error 
messages, then the folder access should be fine. 
 
If students are not assigned to a specific machine, you may want to test their ability to 
access a project from several machines. Create a new project on one machine. Close the 
project. Move to another computer, and try opening the project using the Open Project 
function from the File menu. 
 
Enable Security 
If the Security tab doesn’t show up in Windows 2000 or XP Pro in the Properties window 
for a folder, do the following: 
• Open Folder Options in Control Panel. (Click Start, click Control Panel, click 

Appearance and Themes, and then click Folder Options.) 
• On the View tab, under Advanced settings, clear Use simple file sharing. 
 
Further information about Windows XP Professional and folder access: 
www.microsoft.com/windowsxp/pro/using/howto/security/accesscontrol.asp 
 
 
 

http://www.microsoft.com/windowsxp/pro/using/howto/security/accesscontrol.asp
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